Course Notes

CIVIL AND SURVEYING SOFTWARE
THE 12d PERSPECTIVE

12d Model

V7 STORMWATER UPDATE
12d V7 Stormwater Update Notes

These course notes assume that the trainee has the basic 12d Model skills usually obtained from the “12d Model Training Manual”

These notes are intended to cover basic Stormwater Design. For more information regarding training courses contact 12d Solutions Training Manager.

These notes were prepared by
Robert Graham

Revised June 2005

Copyright © 12d Solutions Pty Limited 2004

These notes may be copied and distributed freely.

Disclaimer

12d Model is supplied without any express or implied warranties whatsoever.

No warranty of fitness for a particular purpose is offered.

No liabilities in respect of engineering details and quantities produced by 12d Model are accepted.

Every effort has been taken to ensure that the advice given in these notes and the program 12d Model is correct, however, no warranty is expressed or implied by 12d Solutions.

Copyright © 12d Solutions Pty Limited 2004
COURSE NOTES

STORMWATER DESIGN

1.0 Drainage Network Editor ................................................................. 5
1.1 Setting manholes names (and pipes)....................................................... 6
1.1.1 Displaying View Text....................................................................... 7
1.2 Labelling the Manholes and Pipes.......................................................... 8
1.2.1 Turn off View Text Manhole Labels................................................... 10
1.2.2 Moving Text..................................................................................... 11
1.3 Catchment Areas.................................................................................. 12
1.4 Network Editor - Global, Default Settings and Explicit Settings.......... 19
1.5 Drainage Templates............................................................................ 19
1.6 Network Editor - Hydrology................................................................. 19
1.6.1 Catchment Areas ................................................................. 19
1.6.2 Coefficients of Runoff................................................................. 20
1.6.3 Percent Impervious......................................................................... 21
1.6.4 Times of Concentration................................................................. 21
1.7 Catchment Characteristic Strings.......................................................... 22
1.7.1 Catchment slope (equal area)......................................................... 23
1.8 Network Editor - Hydraulics................................................................. 24
1.8.1 Pipe Friction Method................................................................. 25
1.8.2 Pit Losses Ku, and Direct Flow....................................................... 25
1.8.3 Pipe Friction Values and Freeboard Limit ......................................... 26
1.8.4 Outlet and Tailwater Conditions..................................................... 26
1.9 Pipe Design Parameters - Sizes, Invert alignment, Min Cover , Max Height 27
1.9.1 Invert Alignment Modes............................................................... 27
1.9.2 Pipe sizes, Max pipe height and Multiple Pipes and Box Culverts...... 28
1.10 Pit Setout - x,y, level, road chainage and setout offset........................... 28
1.11 Calculate overland flow routes ............................................................ 31
2.0 Service and Utility Clashes.................................................................. 32
3.0 Drainage Design in 12d Drainage Design.................................................. 35
3.1 12d Rational Method Hydrology - Drainage Rainfall Editor .................. 35
3.1.1 IFD Tables.................................................................................... 35
3.1.2 Australian Rainfall and Runoff 1987 Method..................................... 36
3.1.3 Australian Rainfall and Runoff 1977 Method..................................... 37
3.2 Drainage Network Design................................................................. 38
3.2.1 Design Results............................................................................ 42
4.0 Drainage Data Input and Output to Spreadsheets...................................... 44
4.1 12d to spreadsheet transfers............................................................... 44
4.2 Spreadsheet to 12d transfers .............................................................. 45
4.2.1 Updating an Existing Model.......................................................... 46
4.2.2 Creating a New Model................................................................. 47
4.3 “12d drainage spreadsheet” Format...................................................... 48
4.4 12d Drainage Variable Names.............................................................. 50
5.0 Reviewing, Changing and Creating User Defined Attributes..................... 51
6.0 Manhole/Pit Schedules........................................................................ 52
7.0 Long Section Plotting.......................................................................... 55
8.0 Locating Crests and Sag Points ............................................................ 59
1.0 Drainage Network Editor

The drainage network editor is used to automatically or manually change the attributes of your drainage network. These abilities include:

**General**
- Setting manhole names

**Hydrology**
- Catchment Areas
- Checking the Automatic Catchment Linking
- Global and Defaults Tab
- Drainage Templates

**Hydraulics**
- Outlet and Tailwater Conditions

The drainage network editor is accessed through the main menu by selecting **Design=>Drainage-Sewer=>Network Editor**.

The bottom section of the network editor panel is shown below.

To begin select a 12d drainage manhole that is in your drainage model.

**You must pick and accept the manhole and not the pipe!** Pipes cannot be used to pick the network!

The manhole that was selected is highlighted with a circle and an arrow shows the direction of flow (see image below).
The option buttons on the drainage editor now become active.

1.1 Setting manholes names (and pipes)

If your network was created from 2d strings the manholes will be named incrementally using integer numbers. Use the drainage network editor to manually change explicit ones or quickly change all the names using a different naming method.

The manhole names are based on the string names so make sure the string names are set. To view string names on the plan view, go to the Plan View tool bar and select Toggle=>Names. If they do not appear see Displaying View Text. The string names may be changed using String->Strings Edit->Change. When using this function always....

**Enter the new name BEFORE selecting the string!**

Select Set Pit Names and the following panel will appear.
1.1.1 Displaying View Text

After you have named the manholes in your network, the names should appear beside each manhole in the plan views. If they do not appear check the following.

After you have named the pits in your network, the names should appear beside each pit in plan. You can change the text size for each string by selecting Strings=>Editor and then pick-accept the drainage string. The text size is set from the selection Utilities=>Size.

The offset from the pit is set by selecting Strings=>Properties=>Strings, picking the drainage string and setting the values for Delta x, and Delta y.

Note: Auto pit names are NOT shown in the section view.

Trouble shooting auto pit names not being displayed

Problem Solution

Plan text is toggled off select Toggle on the plan view title area
1.2 Labelling the Manholes and Pipes

To label the manholes and the pipes use Drainage Plan Annotations. This may be accessed from one of three locations. From the plan toolbar:

- Check that the Text is toggles on. If it is on then walk right and ensure the text is turned on or n/a for your drainage network.

  Small text is turned off select the **Menu** button on the **plan view title area** and select **Settings** =>**Text** => **Text**
  
  - if these values are too large the text will not appear on the screen. Either decrease these values or increase the text size.

  ![Image of Text settings]

  Select drop down and change to **full**

  **Quick threshold and None threshold** if these values are too large the text will not appear on the screen. Either decrease these values or increase the text size.

  String text size is 0
  
  Each drainage line can have its own size of the text. To change it, select **Strings=>Editor** then pick-accept the drainage string. The text size is set from the selection **Utilities=>Size**. If this is set to zero the labels are not drawn.
or Design->Drainage-Sewer->Plots->Plan annotations
or Plot->Plot and ppf editors->Drainage plans
or from the Drainage Network Editor - Plot Button

Note (The following panel has been reduced in size).

Option 2 is to select the **Drainage Network Plot Button**, the following panel will be displayed.
By default, the manholes are labelled with the name, chainage, depth and size. The pipes are labelled with their size in mm, the invert levels and the normal direction of flow. The text properties can all be customised using the plot parameter file but this will be discussed later in the plotting section.

These labels are **not** automatically updated when you change the names or pipe diameters. You must rerun the labelling routine to update the labels.

### 1.2.1 Turn off View Text Manhole Labels

To turn off the automatic view text manhole labels for this view select Toggle=>Text and then walk right to select the drainage model. Do not click on Text, rather walk right. If you click Text you will...
1.2.2 Moving Text

The labels created may be manually moved using the CAD toolbar but if the model is relabelled the text will return to its original location! Text moved via the Drafting->Multi string translate will remain in the moved position when Smart Clean is selected in the Plan Annotation panel.

Before selecting text turn on your text snap.

To move a single line of text use the CAD toolbar. Select the Move text justify button. To use this toolbar you must drag the Create text button to the right and then release when the pointer is on the Move Text Justify Point.

To move a pre-defined Group of text select
1.3 Catchment Areas

Catchment areas for your hydrological model may be defined using a Super, 2d, 3d or polyline string to set the catchment boundaries. Other ways to set the areas are: manual entry in the network editor, via a spreadsheet program, the Top 10 Attribute Editor or the ILSAX pipe editor.

Note that if a catchment string is created to define the area for a manhole then all other data entry types will be ignored and the area from the string will be used.

There are 3 sets of catchments and it is up to the user to decide how they are to be used. Often set 1 will be all the impervious areas and set 2 the pervious and set 3 for special areas. Each set of catchments has its own model. Another option is to have only one set of catchments and to use the percent impervious field.

If exporting to external drainage design programs they may note accept all three sets so check the interface notes before defining the catchments.

In each set/model, 12d will automatically link the catchment string to the manhole that is closest to the first point on your catchment string. This is the preferred method. If this is not possible, then a manhole may be manually linked to a catchment string using the Catchment manual link.

Also see Checking the Automatic Catchment Linking

Drawing Catchment Strings in 12d

Before creating the catchment string set the CAD control bar data.

Type the name of a model for the catchment strings

Now to create the catchment string use the Create line string button on the CAD toolbar.
COURSE NOTES

**STORMWATER DESIGN**

Drag the Create line button and release at the Create Line String button.

The first point should always be placed near the manhole. 12d will assume that the catchment will drain to the manhole closest to this first point.

There is no need to go “overboard” with the accuracy of the. From experience, it is more important to spend time verifying catchments in the field than spending a lot of time getting them “exactly” placed on the catchment plan. If you want to use the drawing as a catchment plan submission then the extra care in creating the strings may be warranted. Continue selecting and accepting the points on the catchment string.

**SAG inlet catchments: DO NOT START AT THE INLET, just start nearer to this inlet than any other!** If you start at the inlet then move out to the crest of the catchment, the catchment overflow level cannot be determined from the catchment string.

For the last point on your catchment line select Close from the CAD toolbar. This function places the last point on the string over the first point on the string forming a closed polygon.

Once the catchments are drawn they become linked to the drainage network in the **Drainage network editor**. We will label the catchment with the manhole name and area at the same time.

Start the **Drainage network editor** and move to the **Global** Tab and then the **Utility Models** sub tab.
We now need to create a label textstyle if you do not have any favourites defined.
Select the **textstyle** button and then the drop down for **Favourites**. Now select **Edit**.

Enter the data as show. Some data you will have to type on the keyboard (**type**) and other you may use the right mouse button (**RB**) and then select browse.

Select **Set** to store the textstyle favourite for this session only. To permanently save this textstyle favourite and have access to it in all of your projects select **Write** and the following...
Select the **User folder**.

Select **Write** to save the favourite to the **User folder**.

If you are in a network environment and want to see if you have write access to this file select the **Properties** button.

Finally select **Set catchments**. This will link the catchments to the manholes and label the catchments. Now add the model **labels** onto the plan view.
COURSE NOTES

STORMWATER DESIGN

There are some cases where linking the closest manhole to vertex 1 is not feasible. In these cases you may manually link the manhole to a catchment.

Catchment manual link

The manual links are used when the first point on the catchment string is closest to the wring manhole. Note that the following restrictions still apply.

1. The string selected for catchment 1 must be in the model for set 1. To check if you have selected a valid string select the Set Catchments button.

2. If the catchment string has already been linked to another manhole (automatic or manual) then the new link will be created and the old link erased.

3. If you change the catchment model for one of the sets on the Network Editor->Global->Utility Models->catchments than all of the manual links in that set will be erased.
Checking the Automatic Catchment Linking

The automatic manhole-catchment linking is easily checked by specifying a Catchment labels model with Labels text style on the Global -> Utility models tab and selecting the Set Catchments button on the network editor. Also once the Set Catchments has been selected, the catchment is indicated when the manhole is selected using the network editor. Since there may be three catchments per manhole the catchment data last viewed in the editor is the catchment that is highlighted.

The catchment strings may be drawn in a CAD package and then imported into 12d or drawn inside 12d. The strings may be easily drawn in 12d with the tin contours and/or flow arrows displayed in the plan view.
1.4 Network Editor - Global, Default Settings and Explicit Settings

Design values for the hydrology and hydraulics calculations are set either globally (one value for the entire network) or via Defaults for the manholes or pipes. Defaults values may be overridden by explicit settings found on the catchment, pits or pipes tab. Explicit manhole/pipe settings need only be specified if the default value is not desired.

1.5 Drainage Templates

The default and global settings may be saved as a template for other projects/networks. Set the defaults for a network and then export the model using File IO->Data output->12da/4da data. This file may now be imported to another project via File IO->Data input->12da/4da data. Since the global and default values are stored as model attributes, they will be imported with the network.

Tip: If you do not want the drainage system imported then delete them from the model before exporting the 12da file.

1.6 Network Editor - Hydrology

The network editor edits both the network and catchment data and it has already been introduced in the previous sections. This section will discuss the Hydrology Global, Defaults and explicit setting for the hydrology parameters. The parameters described on the defaults tab will also be found on the Catchment or Pit tabs.

1.6.1 Catchment Areas

The catchment areas have already been discussed in the previous section. There is no default catchment area to apply to all catchments (as would be expected).

Note! If a catchment string is linked to the manhole and the Set catchments button is selected, this string area will override any manual value that you type into the drainage area field. To ensure manual entry is maintained, RB select the string selection button and select Clear.
1.6.2 Coefficients of Runoff

Runoff C methods include **Direct** and **ARR 1987**. For the **ARR 1987**:

**Direct**: There is a global impervious C value for both the minor and major storms.

**ARR 1987**: The composite C value is calculated using the **1hr-10yr intensity**, the percent impervious, ARR frequency factors and the return period specified when hydrology runs are made.

The **ARR 1987** has no explicit settings. The **Direct** method has both **defaults** and **explicit settings** on **Catchment** tabs (see below).
1.6.3 Percent Impervious

The default percent impervious for the network is set on the **Defaults->Catchment Defaults** tab and the **explicit settings** are on the **Catchment** tab (see above). The percent impervious is used to determine the area for the impervious and pervious components and the composite C value if using the **ARR 1987** method for calculating runoff coefficients.

### Times of Concentration

There are several methods for entering times of concentration for the catchment areas (see list below). Default and explicit settings (catchment tabs) are entered/calculated for both the methods and values for the pervious and impervious areas. Since each catchment may use a different tc method all of the tc parameter fields on the defaults tab are active. They must be filled in even if you do not plan on using that value.
1. **Direct method** requires minor and major tc values.

2. **Friend** and **Kinematic Wave** methods require the retardance, length and slope of the catchments to be entered. Default values must be entered but the optional *explicit settings* for slope and length can be entered on the catchment tabs or a catchment characteristic strings may be drawn (see **Catchment characteristic strings**). The length of this string is used for the length parameter and the design tin is used with the string to calculate the slope using the equal area method.

3. Data for the remaining methods is entered in a similar fashion.

1.7 Catchment Characteristic Strings

These strings are drawn in two models; one for the impervious paths and one for pervious paths. The models are specified using the **Catchment file** field on the **network editor** (Global->Utility model tab). The 3 rows in the **catchment file** correspond to the 3 catchments available for each manhole. Therefore it is possible to have a maximum of 6 catchment characteristic models!
1.7.1 Catchment slope (equal area)

The length of this string is used for the length parameter and the design tin is used with the string to calculate the slope using the equal area method. These strings are drawn from upstream to downstream, finishing nearest to the manhole they are to be linked to. The line style for these strings must be the flow line style found under Drainage 12d in the linestyle drop down list.
The equal area slope is calculated at export time. After the export the slope string, it may be profiled to see the slope (see below).

1.8 Network Editor - Hydraulics
This section will discuss the hydraulic **Global, Defaults** and **explicit settings** for the hydraulic parameters. The **explicit settings** for the parameters described on the **defaults** tab will also be found on the **Pit** or **Pipe** tabs.
### 1.8.1 Pipe Friction Method

The **Global** friction loss method for the pipe roughness method is set here (*Colebrook* or *Manning*). The default **pipe friction values** values are set on the **Defaults>Pipes** tab.

The ranges for pipe peak velocities are used for checking purposes only. If the velocities are outside this range, warning messages will be given in the output window.

If the setout point was on top of the kerb, enter the **Setout to grate offset** so that the overflow level of the manhole can be determined.

The **Direct flow** (cms/cfs) is water flowing into the manhole. It is not added to the approach flow and therefore is not affected by manhole inlet capacity.

The **Pit loss Ku** is used to model the energy losses through the manholes.
1.8.3 Pipe Friction Values and Freeboard Limit

The global pipe friction method on the Global tab determines which fields are active, Colebrook k or Mannings. The default value for the selected method is entered here.

The Freeboard limit is the limit for the upstream manhole (after the ku has been applied). The freeboard is measured from the grate level (setout level minus setout t grage offset).

1.8.4 Outlet and Tailwater Conditions

The most downstream manhole on each network requires tailwater conditions. Often the invert level on the downstream end of the last pipe also needs to have the level locked to either discharge into a waterway or join into an existing drainage system. When the most downstream manhole is selected the following fields will become active on the Network Editor - Pit - Main tab. If these field are not active and you think you are at the outlet see Flow in the Wrong Direction.

Minimum will use the least of the Critical or Normal depths. If a fixed level is available for the minor and/or major storms, these value may be entered here. The Pit sump level is used to enter the sump level of the network that is being connected to (Optional).
COURSE NOTES

STORMWATER DESIGN

1.9 Pipe Design Parameters - Sizes, Invert alignment, Min Cover , Max Height

The invert levels during design are controlled by the pipe sizes, max pipe height, min pipe cover and invert alignment mode.

1.9.1 Invert Alignment Modes

12d has 3 design modes for setting the pipe inverts upstream and downstream of the manholes. These work together with the 2 pipe cover modes as follows.

The tin specified in the Global-Main Finished Surface Tin field is used for these calculations. The description below assumes that none of the inverts have been manually locked.

NOTE! Invert design parameters are set on the Pipe-Design tab not the Pit tab. The Alignment mode refers to the DOWNSTREAM INVERT ONLY.

1. The initial pipe grade is set as the Minimum grade (Minimum Grade mode) or the grade between the ground levels at the manholes (Minimum Depth mode). Even in the Minimum depth mode the minimum grade constraint is checked.

2. 12d shifts the pipe down so that there is at least the Pipe cover limit along the pipe. The Pipe cover limit should include an amount for the pipe thickness.

3. Inverts are moved down if required according to the setting in Alignment mode.

Obverts are aligned using Obvert Drop with a zero Alignment drop and similarly the inverts are aligned with the Invert drop mode. Minimum drop ensure that the inverts drop a minimum of the specified drop but the drop may well be more than the Alignment drop specified. As the inverts are moved down the minimum pipe grade is maintained.

NOTE! If Obvert Drop is selected and the downstream pipe is a smaller pipe then the inverts will be aligned!
STORMWATER DESIGN

1.9.2 Pipe sizes, Max pipe height and Multiple Pipes and Box Culverts
The 12d design engine will select pipe sizes from the file specified on the Drainage Network Design panel, Preferred pipes file fieldlist. See selecting pipe sizes. However, the maximum pipe height allowed before multiple pipes are used and the selection of box culverts is set on the pipe >main and pipe >design tabs respectively.

To specify a box culvert in your network, select the pipe segment and enter a width for the pipe.

For box culverts, the design engine increases the widths and maintains the height through the available sizes. Once the maximum height has been reached, the next culvert height and minimum width is checked.

On the Pipe->Design tab the max pipe height can be set for each pipe segment (there is no default for this value). If the 12d design engine requires a larger pipe, then multiple pipes will be selected.

1.10 Pit Setout - x,y, level, road chainage and setout offset
The construction setout point defines the location on the manhole to be printed in the manhole schedules, plotted on the plan annotations or listed on the drainage long sections. The setout point...
and level can be set to the centre of the manhole or it can be linked to a road design string.

The centre of the manhole or setout point can also be dropped perpendicular onto the road centre line to obtain the road chainage and offset distance.

**Pit centre** is the centre point of the manhole (the intersection of the joining pipes). Often the setout point for a manhole or catch basin is not the centre of the manhole but rather a point on the kerb or back on the foot path. The *setout string* option will drop the centre point of the manhole onto the closest string in the Road design model list specified on the Global->Utility models tab. The manhole cover level will be set to *level on this string*.
The Centre string ID is used in the same way to find the centre line string. If needed, this string is used for road change and to determine which direction to measure the crossfall (between the setout string and the centre string).

The distances and searches are optional. The setout and centre search distances are the maximum distance that the routine will look when trying to locate the setout and centre line strings respectively.

The grade offset it the distance upstream from the setout point that the road grade measurement will start and the Xfall offset is the distance from the setout point to the start of the crossfall measurement. The measurements will be taken over a distance of slope measurement distance with the actual levels taken from the finished surface tin specified on the Global-Main tab.

Repeat this for each road string model used in the design. Remember to select Write when fin-
1.11 Calculate overland flow routes

This option is required for manhole inlet capacity calculations and is covered in the advanced drainage training.

As an introduction, the overland flow parameter routine determines the road grade, crossfall, manhole inlet capacity and downstream bypass manhole for each manhole. To achieve accurate measurements for the road grade and crossfall, the manhole is linked to a setout string (see below).
2.0 Service and Utility Clashes

WARNING!

12d service clash routines notify the user of crossing services but not parallel services that are close to each other. To view parallel services, add the services model onto a section view, profile a drainage string and then set the corridor value for the section view.

Settings->Corridor and then set the **Width left** and **Width Right** to the desired clearance. If the service can be seen then it is within the tolerance. 11 is used in this example only so that you can see the service on the other side of the road.

Use the **Next** and **Prev** button to switch drainage strings.

To obtain a report of all strings inside or crossing the drainage string profiled, select the **View menu** button then **Utilities->Report**

The service clash model list is entered on the **Global-Utilities Model** field.
To create a list enter a list name, select the folder icon and then select edit.

In the Service model column RB to select the model. Enter Minimum Clearance for the services in this model. If different clearances are required for different services then place the services in different model. Warnings will be issued at design time. Cover levels or fixed inverts can be used to avoid the services.

Service clashes are listed in the output when the Set pipe inverts is selected on the Drainage Network Editor. If the output window is not visible then from the main menu select Window->Output Window

and make sure it is selected.
Once the invert levels have been reset the output window will indicate the final clearance.

After a pipe design run details of the service clash data will again be listed in the output window.
3.0 Drainage Design in 12d Drainage Design

12d has a sophisticated rational method hydrology and hydraulic grade line pipe design engine. In addition it has the capability to export this data to several other popular drainage packages. Regardless of the design method selected the drainage network in 12d is updated from the design so that drainage plans, long sections and manhole schedules can be quickly produced.

3.1 12d Rational Method Hydrology - Drainage Rainfall Editor

The Drainage Rainfall Editor is used to input rainfall IFD data using several methods. The data is stored in Meteorology files (each file is for a specific location) that can be shared between 12d projects. The data is edited using an editor similar to those used for the plot parameter files (ppf). Seven methods for entering/calculating the rainfall intensities are shown in the panel below. From the main menu select,

Design->Drainage-Sewer->Rainfall Editor

Data is entered using one (or more if desired) input methods and then saved by entering a Meteorology file name and selecting Write. The standard 12d system file search paths are used (project folder, user library folder and then library folder).

Select the folder icon and then walk right on the Lib item to display a list of sample files. Select a file the select Read. YOU MUST SELECT THE READ BUTTON!

3.1.1 IFD Tables

IFD tables are often available from meteorological services. The table input format follows. The first row is used to define up to 9 return periods and the following rows list the rainfall intensities.
3.1.2 Australian Rainfall and Runoff 1987 Method
The rainfall intensities and other factors from Volume 2 of ARR 1987 are entered in this table.
3.1.3 Australian Rainfall and Runoff 1977 Method
The seven coefficients for each return period from ARR 1977 are entered in this table.
3.2 Drainage Network Design

The Drainage Network Design panel executes the 12d drainage design, plots the drainage long section and plan annotation and prepares the hydrology and hydraulic design tables. From the main menu select

Design->Drainage-Sewer=>Drainage Network=>Drainage Network Design

or from the Drainage Network Editor select Storm Analysis

The following design panel will appear.
If you have launched the panel from the network editor, the Drainage network model field will be completed. Otherwise select the drainage network model.

In general the Analyse network is always selected. If you only want to plot or create the reports then remove the tick.

Storm Factors

Select the folder icon on the Rainfall location file and then walk right on the Lib line to select one of the rainfall files in the 12d library. If the file has only one type of rainfall definition then the Rainfall method field will be completed. Otherwise select the Rainfall method desired. The valid Return period will depend of the method selected but you cannot extrapolate beyond your data.

Event type determines which set of design values (minor or major) will be used for this run. Enable the 12d rational method engine partial area calculations by selecting the Partial area effects box.
Network Design Factors

Selecting Pipe Sizes

These values control the values to be designed in the run. If Design pipe sizes is selected then a file containing the available pipe sizes must be supplied. The pipe sizes in this file are in the Units specified at the top of the panel (metre for metric, feet for US). To create a new file, enter the file name and then select the folder icon followed by the Edit line. The following panel will appear.

The Upsize only selection will stop pipes in the system from being reduced in the design. Regardless of this selection, the 12d design engine will not allow a smaller pipe to be selected in the downstream direction.

Generate Results in Plan

This selection automatically runs the drainage plot annotation function. A Drainage plan ppf must be entered and samples are supplied in the 12d library. A Model for plan results is required if this option is selected. The Clean model before hand tick box forces the model to be cleaned before the labels are created. When not selected a “Smart clean” is performed.

Generate Results in Long Section

This selection automatically runs the drainage long section plotter. A Drainage long section ppf is required and examples are found in the 12d library. A Model stem for long section results is required if this option is selected. In almost all cases the Clean model before hand tick box should be selected.

YOU MUST SELECT THE WRITE BUTTON!
COURSE NOTES

STORMWATER DESIGN

Generate hydrology report

The hydrology report may be formatted for inserting into a 12d model/text editor (formatted) or spreadsheet (comma or tab delimited). In almost all cases Overwrite existing report file will be selected.

Importing Text into a 12d model

Formatted text may be inserted into a 12d model by selecting

Drafting->Text and Tables->Create edit paragraph text

Change to File.
Select the folder icon and then pick the formatted text file. It will be displayed then select Set.

Next select the location in plan for the text.
The font selected must be a fixed space font or the data will not align properly.

Select the Font to display the following panel.
Enter a **Text Model** for the report. The **Text Style** must be a fixed space font. Select **Set** then **Finish**.

Now add the **Text Model** onto the...

---

**Generate hydraulic report**

The **hydraulic report** may be formatted for inserting into a 12d model/text editor (formatted) or spreadsheet (comma or tab delimited). In almost all cases **Overwrite existing report file** will be selected.

If you want both the hydrology and hydraulic report in the same file, enter the same file name in both file fields but turn off the **Overwrite existing report file** for the hydraulic report.

---

### 3.2.1 Design Results

Results from the design runs are shown in several forms:

1. Hydrology and hydraulic reports
2. **Drainage plan annotations**
3. **Drainage longsections**
4. Hydraulic Grade line on the Section view
5. Output window data - Service/utility clashes

Samples of the hydrology and hydraulics report are shown below.
### 12D MODEL - HYDROLOGICAL DESIGN SHEET

**Minor 2 Year Storm Event**

**Project:**

**Drainage Network:** drainage network

**Location File:** SELGRID ACT Canberra.12dhydro

**To Method:** Direct

**Rainfall Method:** APR 1987

**Perfurion C Method:** APR 1987

<table>
<thead>
<tr>
<th>ID</th>
<th>Type</th>
<th>TO</th>
<th>Time</th>
<th>Intensity</th>
<th>Runoff</th>
<th>Iq</th>
<th>Area</th>
<th>Component</th>
<th>Full CA</th>
<th>Full q-CA</th>
<th>Full q</th>
<th>Partial CA</th>
<th>Partial q</th>
<th>Partial q-CA</th>
<th>Partial q-CA</th>
<th>Inlet</th>
<th>Inflow</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-1</td>
<td>Pervious</td>
<td>10.00</td>
<td>55.25</td>
<td>0.53</td>
<td>0.0827</td>
<td>0.0083</td>
<td>0.0044</td>
<td>0.0714</td>
<td>11.00</td>
<td>0.0622</td>
<td>0.0692</td>
<td>14.00</td>
<td>14.00</td>
<td>MH</td>
<td>14.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1-2</td>
<td>Impervious</td>
<td>5.00</td>
<td>72.65</td>
<td>0.90</td>
<td>[90]</td>
<td>0.0745</td>
<td>0.0670</td>
<td>0.0670</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1-3</td>
<td>Impervious</td>
<td>5.00</td>
<td>72.65</td>
<td>0.90</td>
<td>[90]</td>
<td>0.0745</td>
<td>0.0670</td>
<td>0.0670</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2-1</td>
<td>Pervious</td>
<td>10.00</td>
<td>55.25</td>
<td>0.53</td>
<td>0.0573</td>
<td>0.0053</td>
<td>0.0028</td>
<td>0.0459</td>
<td>7.00</td>
<td>0.0314</td>
<td>0.0445</td>
<td>9.00</td>
<td>9.00</td>
<td>CONC COVER</td>
<td>9.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3-1</td>
<td>Pervious</td>
<td>10.00</td>
<td>55.25</td>
<td>0.53</td>
<td>0.0573</td>
<td>0.0053</td>
<td>0.0028</td>
<td>0.0459</td>
<td>7.00</td>
<td>0.0314</td>
<td>0.0445</td>
<td>9.00</td>
<td>9.00</td>
<td>CONC COVER</td>
<td>9.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4-1</td>
<td>Pervious</td>
<td>5.00</td>
<td>72.65</td>
<td>0.90</td>
<td>[90]</td>
<td>0.0745</td>
<td>0.0670</td>
<td>0.0670</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

### 12D MODEL - HYDRAULIC DESIGN SHEET

**Minor 2 Year Storm Event**

**Project:**

**Drainage Network:** drainage network

**Runoff Coefficient:** 0.01

**Pipe Cover Unused:** 1.1 m

**Simulation Time:** 24 minutes

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1.1 to 1.2</td>
<td>PVC 1</td>
<td>11.0</td>
<td>11.0</td>
<td>48.5</td>
<td>48.5</td>
<td>28.0</td>
<td>28.0</td>
<td>27.0</td>
<td>27.0</td>
<td>26.0</td>
<td>26.0</td>
<td>25.0</td>
<td>25.0</td>
<td>24.0</td>
<td>24.0</td>
<td>23.0</td>
<td>23.0</td>
<td>22.0</td>
</tr>
<tr>
<td>1.2 to 1.3</td>
<td>PVC 2</td>
<td>48.5</td>
<td>48.5</td>
<td>28.0</td>
<td>28.0</td>
<td>17.0</td>
<td>17.0</td>
<td>16.0</td>
<td>16.0</td>
<td>15.0</td>
<td>15.0</td>
<td>14.0</td>
<td>14.0</td>
<td>13.0</td>
<td>13.0</td>
<td>12.0</td>
<td>12.0</td>
<td>11.0</td>
</tr>
<tr>
<td>1.3 to 1.4</td>
<td>PVC 3</td>
<td>74.5</td>
<td>74.5</td>
<td>48.5</td>
<td>48.5</td>
<td>28.0</td>
<td>28.0</td>
<td>27.0</td>
<td>27.0</td>
<td>26.0</td>
<td>26.0</td>
<td>25.0</td>
<td>25.0</td>
<td>24.0</td>
<td>24.0</td>
<td>23.0</td>
<td>23.0</td>
<td>22.0</td>
</tr>
<tr>
<td>1.4 to 1.5</td>
<td>PVC 4</td>
<td>48.5</td>
<td>48.5</td>
<td>28.0</td>
<td>28.0</td>
<td>17.0</td>
<td>17.0</td>
<td>16.0</td>
<td>16.0</td>
<td>15.0</td>
<td>15.0</td>
<td>14.0</td>
<td>14.0</td>
<td>13.0</td>
<td>13.0</td>
<td>12.0</td>
<td>12.0</td>
<td>11.0</td>
</tr>
</tbody>
</table>
4.0 Drainage Data Input and Output to Spreadsheets

Spreadsheets are an effective method to manage the numerous variables urban drainage designers create in the modelling process. Spreadsheet data can be transferred to and from 12d in tab delimited files and stored within 12d as “user definable attributes”. These attributes are linked to the pit and pipes within a network. Drainage long section plots can display the pipe attributes in the “arrows” data area.

Drainage strings will be created if they do not exist in the model but manholes cannot be added to existing strings.

See also

12d to spreadsheet transfers
Spreadsheet to 12d update and create
Spreadsheet options

4.1 12d to spreadsheet transfers
This interface is accessed the Import/Export button on the Drainage Network Editor.
4.2 Spreadsheet to 12d transfers
This item is accessed from the Import/Export button on the Drainage Network Editor.
The following panel will appear.

Select Export
Select Spreadsheet clipboard
These options are not used for spreadsheet export.
Select to export the junction pit at the end of all drainage lines.
You may also select to limit the output if desired. If you like using spreadsheets for data entry, the PCdrain data and ILSAX data formats are useful for adding data for the first time for either program.
Select Run to place the data on the clipboard.
4.2.1 Updating an Existing Model

The data usually generated by 12d using the Copy button, pasted into a spreadsheet and then copied back to the clipboard so that 12d can be updated. To update the 12d drainage network select the Paste button. The data must be in the “12d drainage spreadsheet” format.

When 12d exports the drainage model to a spreadsheet it includes a column for the unique string identifier and a unique manhole identifier (unique to the drainage model not the 12d project). The names of the strings and manholes may be changed via the spreadsheet if these columns are present at import time.

If the manhole id column is not present, 12d will search the drainage model for a matching manhole.
name. When the manhole is a junction between drainage lines, only the trunk line will be the data updated.

4.2.2 Creating a New Model
It is possible to create a new string or an entire drainage network using this format. However, manholes cannot be added to an existing string. The entire drainage string must be created at once. Two formats are available, the “from-to manhole” format and the “12d drainage spreadsheet” format.

12d drainage spreadsheet Format
The top left cell in the clipboard data must be the text “12d” to specify this format. The minimum amount of data required to create a new string is the string name, manhole name, x and y coordinates. You can add as much additional data as you have available. This would include pipe diameters inverts etc. The manholes must be listed from upstream to downstream order. If the string is to join a trunk line, the junction manhole must be included for both the tributary and the trunk line. More information on the format.

An example file exists called new_network.txt is supplied in the library. Open this file in a spreadsheet or a text editor and copy it to the clipboard. Enter a new model name in the Drainage model field and select paste. The new drainage model will now exist.

From-to Manhole Format
The top left cell in the clipboard data must be the text “from to” to specify this format. The minimum amount of data required to create a new string is the upstream pit name (*pit name), the downstream pit name (*ds pit name) and the x(x location) and y(y location) coordinates of the upstream pit. If the string is to join a trunk line, the junction manhole must be included for both the tributary and the trunk line.

An optional column for the manhole cover elev (cover elev) may be specified. Once the network has been created additional pipe and manhole data may be added using the “12d drainage spreadsheet” format described above.

An example file exists called new_from_to_network.txt is supplied in the library. It is shown below. Open this file in a spreadsheet or a text editor and copy it to the clipboard. Enter a new model name in the Drainage model field and select paste. The new drainage model will now exist.
4.3 “12d drainage spreadsheet” Format

Each column of data is used for a 12d drainage variable or a user defined attribute. Each row represents a manhole and the downstream pipe (controlled by the direction of flow variable) within the drainage network. A sample is shown below.

<table>
<thead>
<tr>
<th>From to</th>
<th>Pit</th>
<th>Pit</th>
<th>Pit</th>
<th>Pit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pit name</td>
<td>&quot;ds pit name&quot;</td>
<td>x location</td>
<td>y location</td>
<td>cover elev</td>
</tr>
<tr>
<td>text</td>
<td>text</td>
<td>real</td>
<td>real</td>
<td>real</td>
</tr>
<tr>
<td>E/1</td>
<td>A/3</td>
<td>5309.458</td>
<td>7336.939993</td>
<td>29.2173</td>
</tr>
<tr>
<td>D/1</td>
<td>A/4</td>
<td>5277.169</td>
<td>7336.939993</td>
<td>28.5071</td>
</tr>
<tr>
<td>C/1</td>
<td>B/3</td>
<td>5251.238738</td>
<td>7423.94685</td>
<td>31.5257</td>
</tr>
<tr>
<td>A/1</td>
<td>A/2</td>
<td>5354.629222</td>
<td>7336.939993</td>
<td>30.2115</td>
</tr>
<tr>
<td>A/2</td>
<td>A/3</td>
<td>5340.019987</td>
<td>7322.039996</td>
<td>29.89</td>
</tr>
<tr>
<td>A/3</td>
<td>A/4</td>
<td>5293.468002</td>
<td>7322.039991</td>
<td>28.8652</td>
</tr>
<tr>
<td>A/4</td>
<td>A/5</td>
<td>5250.182525</td>
<td>7322.039986</td>
<td>27.9127</td>
</tr>
<tr>
<td>A/5</td>
<td>A/6</td>
<td>5217.194202</td>
<td>7322.039983</td>
<td>27.1867</td>
</tr>
<tr>
<td>A/6</td>
<td>A/7</td>
<td>5183.468002</td>
<td>7322.039979</td>
<td>26.4442</td>
</tr>
<tr>
<td>A/7</td>
<td>A/8</td>
<td>5152.698693</td>
<td>7322.039975</td>
<td>25.7672</td>
</tr>
<tr>
<td>B/1</td>
<td>B/2</td>
<td>5209.42875</td>
<td>7422.259079</td>
<td>32.7197</td>
</tr>
<tr>
<td>B/2</td>
<td>B/3</td>
<td>5264.638564</td>
<td>7393.947083</td>
<td>30.7948</td>
</tr>
<tr>
<td>B/3</td>
<td>B/4</td>
<td>5249.736564</td>
<td>7384.207593</td>
<td>30.4167</td>
</tr>
<tr>
<td>B/4</td>
<td>B/5</td>
<td>5249.736564</td>
<td>7351.201545</td>
<td>29.1444</td>
</tr>
<tr>
<td>B/5</td>
<td>A/5</td>
<td>5233.426665</td>
<td>7336.939984</td>
<td>27.544</td>
</tr>
</tbody>
</table>
Duplicate Definitions

Strings Variables such as “direction” are may be defined for numerous manholes on the same string. Searching in a top down direction through the file, the last definition found for the string will be set.

Invert levels may be set via pipe data or pit data or combined. It is recommended that the user only use one method and not combine them. Both are exported so delete the ones you are not going to use. The variables are processed from left to right, so if duplicate definitions of an invert level or found the right most data will be set.

The format definition

1. Row1, column 1 must contain either “12d”, or “from to”. Therefore, the first column must be a 12d drainage variable (cannot be a user defined attribute).

2. Row 1. The text <pit> at the top of the column indicates the column contains a user defined pit attribute and similarly <pipe> indicates a user defined pipe attribute.

3. Row 2. This row contains the names of the 12d drainage variable names and the pit/pipe attributes. All names are case sensitive so be careful where you use capital letters. A list of 12d drainage variables is found below.

Names beginning with an asterix (*) will not be processed (except pit/string names when unique identifiers are present in the data). 12d drainage variables names beginning with an
COURSE NOTES

STORMWATER DESIGN

asterix indicate that this data was calculated at export time and cannot be read back into 12d (for example, pipe length, pipe grade and deflection angle).

Prefixing an user defined attribute name with <DELETE> followed by a space will cause the attribute to be deleted from all pits/pipes within the model.

4. Row 3. The text in this row define the type of attribute to be stored within 12d. The only valid choices are:

    integer
    real
    text

If you want to change an attribute type you must delete the attribute and create it again. If you simply change the attribute type in the third row then that attribute will not be updated.

5. Blank lines may be inserted as desired.

6. You are not required to fill in all of the cells in the spreadsheets. Blank cells are ignored (you must use a space to remove all data from text attributes (the space will not be stored).

7. Pipe names are included in the data so that they can be changed but they are not used to identify the pipe. Pipe data will always be assigned to the pipe following the pit in the direction of ascending chainage. If flow directions is ascending then the pipe data will be for the downstream pipe. If the flow direction is descending then the pipe data will apply to the upstream pipe.

4.4 12d Drainage Variable Names

<table>
<thead>
<tr>
<th>Manhole Variables</th>
<th>Pipe Variables</th>
<th>String Variables</th>
</tr>
</thead>
<tbody>
<tr>
<td>*string Name</td>
<td>pipe name</td>
<td>direction</td>
</tr>
<tr>
<td>*pit name</td>
<td>pipe type</td>
<td>fs tin</td>
</tr>
<tr>
<td>*pit type</td>
<td>low ch invert</td>
<td>ns tin</td>
</tr>
<tr>
<td>*pit diameter</td>
<td>high ch invert</td>
<td>string id</td>
</tr>
<tr>
<td>*pit low ch invert</td>
<td>diameter</td>
<td></td>
</tr>
<tr>
<td>*pit high ch invert</td>
<td>*length</td>
<td></td>
</tr>
<tr>
<td>*pit road chainage</td>
<td>*grade</td>
<td></td>
</tr>
<tr>
<td>*pit road name</td>
<td>low hgl</td>
<td></td>
</tr>
<tr>
<td>*pit angle</td>
<td>high hgl</td>
<td></td>
</tr>
<tr>
<td>*pit drop</td>
<td>pit hgl</td>
<td></td>
</tr>
<tr>
<td>*pit depth</td>
<td>flow</td>
<td></td>
</tr>
<tr>
<td>*pit chainage</td>
<td>velocity</td>
<td></td>
</tr>
<tr>
<td>x location</td>
<td></td>
<td></td>
</tr>
<tr>
<td>y location</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cover elev</td>
<td></td>
<td></td>
</tr>
<tr>
<td>*fs elev</td>
<td></td>
<td></td>
</tr>
<tr>
<td>*ns elev</td>
<td></td>
<td></td>
</tr>
<tr>
<td>*pit id</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
5.0 Reviewing, Changing and Creating User Defined Attributes

The catchment data is stored within 12d as user defined attributes. These attributes are automatically created by 12d when required but you are free to change them or add more as desired. The attributes may be exported to a spreadsheet and edited and then imported back into 12d. To work with the user defined attributes within 12d select

**Design=>Drainage-Sewer=>More=>Top 10 Attribute Editor.**

First **Select Pick** to select the string that contains the user attributes (the drainage string). The strings will be highlighted in white when they are selected.

All catchment data is stored with the manholes in drainage strings. To access the manhole attributes, select the drop down icon and then select **manhole**. A circle will be drawn around the manhole selected. **Next** and **Prev** will now move you from manhole to manhole.

Select the drop down icon and then select the **Attribute Name** from the list of existing user defined attributes. These attributes include all of the attributes in the model that the string exists in.

They may not be defined for the manhole you are editing. **Not found** will be displayed in the **Data** field if the manhole does not have that attribute defined.

To change the value for the attribute enter the new value in the **data** field. If the attribute does not exist, deleting the **not found** text and adding data will create it. The message on the right will be displayed whenever you are creating a new attribute.
6.0 Manhole/Pit Schedules

Manhole/pit schedules or construction tables are generated in tab or space delimited formats. This panel is accessed from the menu selection 
Design => Drainage => More Drainage => Pit schedule

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Defaults</th>
<th>Pop-Up</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drainage model name</td>
<td>input box</td>
<td>drainage network</td>
<td>model containing the drainage strings</td>
</tr>
<tr>
<td>Pit schedule file name</td>
<td>input box</td>
<td>pit report</td>
<td>file to be created</td>
</tr>
<tr>
<td>Report Format</td>
<td>choice box</td>
<td>Road chainage...East...</td>
<td>file format</td>
</tr>
<tr>
<td>Data delimiter</td>
<td>choice box</td>
<td>Tab, Space</td>
<td>tab delimiters are best for spreadsheets and space for some text editors</td>
</tr>
<tr>
<td>Repeat header for each line</td>
<td>tick box</td>
<td>selected</td>
<td>when selected, the column headings will be printed each drainage line</td>
</tr>
<tr>
<td>Calculate road chainage/offset</td>
<td>tick box</td>
<td>selected</td>
<td>only used for road chainage-offset format. When selected, the road chainages and offset calculation panel will be displayed so that the this data can be updated before the report is generated. (see below)</td>
</tr>
<tr>
<td>Easting Northing Location</td>
<td>choice box</td>
<td>pit centre, road design string</td>
<td></td>
</tr>
</tbody>
</table>
easting northing data can be from the manhole centre or the x,y location on the road design string that the manhole has been linked to

Cover elevation location choice box pit centre, road design string

the cover level elevation can be from the manhole centre or the elevation on the road design string that the manhole has been linked to (if a link has been made then these values should be the same). Note that the road design string data is NOT calculated at this time. These are the values calculated from the Drainage Misc Utilities or the last drainage data export.

Process button Create the pit report

Finish button remove the panel from the screen

Notes:
The columns of data may be separated by spaces or a tab. (tab is used for spreadsheet transfers). The internal width and length data are retrieved from the drainage.4d file for the pit type specified. If you want a longer description for the pit then the type used inside 12d this can also be entered in the drainage.4d file. The remarks for each pit are entered as user defined pit attribute named remarks and may be set using the attribute editor (on the drainage menu) or via a spreadsheet.

Eastings Northing Sample

<table>
<thead>
<tr>
<th>Pit No</th>
<th>TYPE</th>
<th>EASTING NORTHING</th>
<th>INTERNAL</th>
<th>INLET</th>
<th>OUTLET</th>
<th>FIN</th>
</tr>
</thead>
<tbody>
<tr>
<td>B1</td>
<td>SA2</td>
<td>5302.458 7336.936</td>
<td>450.000 900.000</td>
<td>375 28.210</td>
<td>29.387</td>
<td>1.177</td>
</tr>
<tr>
<td>A2</td>
<td>SA2</td>
<td>5264.372 7322.036</td>
<td>450.000 900.000</td>
<td>375 27.470</td>
<td>28.646</td>
<td>1.226</td>
</tr>
<tr>
<td>C1</td>
<td>SA2</td>
<td>5224.155 7336.936</td>
<td>450.000 900.000</td>
<td>375 26.690</td>
<td>27.863</td>
<td>1.173</td>
</tr>
<tr>
<td>A3</td>
<td>SA2</td>
<td>5187.910 7322.036</td>
<td>450.000 900.000</td>
<td>375 25.930</td>
<td>27.158</td>
<td>3.628</td>
</tr>
<tr>
<td>A1</td>
<td>SA2</td>
<td>5309.458 7321.100</td>
<td>450.000 900.000</td>
<td>225 28.550</td>
<td>29.577</td>
<td>1.027</td>
</tr>
<tr>
<td>A2</td>
<td>SA2</td>
<td>5264.372 7322.036</td>
<td>450.000 900.000</td>
<td>225 27.470</td>
<td>27.158</td>
<td>3.624</td>
</tr>
<tr>
<td>A3</td>
<td>SA2</td>
<td>5187.910 7322.036</td>
<td>450.000 900.000</td>
<td>375 25.930</td>
<td>23.530</td>
<td>27.158</td>
</tr>
</tbody>
</table>
| A4     | SA2  | 5157.411 7321.332 | 450.000 900.000 | 375 23.090 | 26.714 | 3.624 outlet to existing system

NOTE:
1. ALL SETOUT POINTS QUOTED TO CENTRE OF PIT

Road Chainage Offset Example

DRAINAGE LINE A
PIT    PIT LOCATION    LOCATION OFFSETS
COURSE NOTES

STORMWATER DESIGN

<table>
<thead>
<tr>
<th>No.</th>
<th>EASTING</th>
<th>NORTHING</th>
<th>STATION CTRL</th>
<th>OFFS</th>
<th>TYPE</th>
<th>REMARKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>A/1</td>
<td>5354.629</td>
<td>7336.936</td>
<td>231.171</td>
<td>d002</td>
<td>-7.450</td>
<td></td>
</tr>
<tr>
<td>A/2</td>
<td>5340.691</td>
<td>7320.911</td>
<td>217.233</td>
<td>d002</td>
<td>8.575</td>
<td></td>
</tr>
<tr>
<td>A/3</td>
<td>5293.458</td>
<td>7320.886</td>
<td>170.000</td>
<td>d002</td>
<td>8.600</td>
<td></td>
</tr>
<tr>
<td>A/4</td>
<td>5250.131</td>
<td>7320.886</td>
<td>126.673</td>
<td>d002</td>
<td>8.600</td>
<td></td>
</tr>
<tr>
<td>A/5</td>
<td>5217.194</td>
<td>7322.036</td>
<td>93.736</td>
<td>d002</td>
<td>7.450</td>
<td></td>
</tr>
<tr>
<td>A/6</td>
<td>5183.458</td>
<td>7322.036</td>
<td>60.000</td>
<td>d002</td>
<td>7.450</td>
<td></td>
</tr>
<tr>
<td>A/7</td>
<td>5152.699</td>
<td>7322.036</td>
<td>29.241</td>
<td>d002</td>
<td>7.450</td>
<td></td>
</tr>
</tbody>
</table>

Notes

The Set pit details must be run at least once to before printing the report. If the pits are moved or the designed strings changed then this option must be rerun.

The Road Chainage and Offset Pit Schedules use two user defined attributes for each pit. The first is **ctrl string** which identifies the string that the pit will be offset from and the second is **ctrl model** which contains the model name for the control string. These may be manually created/modified using a spreadsheet or the attribute editor.

The easting northing data obtained for the road design string option is obtained by dropping the manhole centre perpendicular onto the selected road design string. This data is stored as pit attributes **setout x** and **setout y**. It is calculated when the manhole cover levels are recalculated (drainage utilities and during drainage export (recalc level option must not be turned off)).

The cover elevation data obtained for the road design string option is obtained by dropping the manhole centre perpendicular onto the selected road design string and obtaining the elevation at this point. This data is stored as pit attribute **level z**. It is calculated when the manhole cover levels are recalculated (drainage utilities and during drainage export (recalc level option must not be turned off)).
COURSE NOTES

STORMWATER DESIGN

7.0 Long Section Plotting

Detailed description of the 12d drainage long section plotting may be found in the 12d Reference manual. The long section plots are customised using the drainage plot parameter files (drainppf). Title blocks, user defined text may be added and then plotted directly or to various file formats (dwg, dgn etc.). From the main menu

Design=>Drainage-Sewer=>Plots=>Longsections

See Also

manhole Schedules to set road chainage and name data

To access the drainppf files supplied select the icon and then walk right on Lib to select this drainppf file.

Select Read

Enter a new name for this drawing and select Write. This will save the setting we are about to make should you want to replot this long section.

This section view determines the additional models (such as services) to show plot. These are referred to as corridor models. The vertical exaggeration is also obtained from this view.
COURSE NOTES

**STORMWATER DESIGN**

The **network model** field will be completed with the model of the string being profiled. If this is not your drainage network model then select it now.

When **Plotter Type** is set to model then **plot file stem** is the model name prefix for plots that will be created. The first sheet of plots will be in model **plot1**, the second in **plot2** etc.

The **plot height** determines how much room is left vertically for the actual plot. This specifies the total height of the plot. 12d then constructs the box area and arrow area on the bottom and then arrow area on the top. The amount left over is used for the long section itself.

To stop datum breaks from occurring increase this height, increase your plot scale or decrease your vertical exaggeration. If there is too much white space in the graph area then reduce this value.
The **Drainage plot+title block+User title info** allow you to enter the text for the title block. The list displayed is retrieve from the **title file** selected above. Enter the data for the plot and then select **Write** to save the changed to the local drainppf file you entered earlier.

Select **Plot** and the plots will be send to the **plot file stem** entered. These models may be added (one at a time) to a plan view to inspect them before plotting to paper or exporting to other drawing packages.

If changes are to be made and then plotted again you must delete the drawings in the model. These models may be cleaned out using **Models->Clean**
The asterisk may follow the plot file stem to clean all of the models at once. You will be shown the model list before they are cleaned.
8.0 Locating Crests and Sag Points

This step will place tick marks at the crest and sag points of your kerb strings. It is an optional step but it will help ensure that a drainage manhole is always placed at SAG manhole locations.

If your road designer has given you kerb inverts strings split into numerous sections, use the “head to tail” feature described in section 4.2 above before using this section. The crests and sag locations along the design string can be identified using the selection

Strings => Label => Chainages

Enter the model name for the kerb strings.
Select **crests/sags** from drop down list.

Enter a model to contain the text labels. A ,1 after the model name, requests that the model be added to view 1. This saves you adding the model to the view later to see the labels.

Select icon to define the text style.

Optionally select heights and not chainage.

Select the **Marks** property sheet
To get a clear picture of what the kerbs look like in profile let’s create a section view and profile the kerb string.

To obtain more working area, hide the Output Window (Window=>Output window).

From the main menu select,

View=>New=>Section View

Now Select Profile on the section view title area and then pick the kerb string in the plan view. Your screen should now look like the following.
COURSE NOTES

STORMWATER DESIGN

Place your pointer in the section view and notice how the cross in the plan view indicates your position in plan.

We are now ready to add our overland flow paths, drainage manhole/pipes and catchment areas.

THE END